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 Important! This document is 
designed to be viewed online. 
It contains links to several 
online processes and 
procedures, which are not 
available in the printed 
version. 

Introduction 
This document provides answers for the most frequently asked questions about the Rimage 360i 
printer. 

Before you walk through any of these troubleshooting steps, refer to the Rimage 360i Setup and 
Installation Guide to verify that the equipment is set up correctly. 

Select the type of problem you are experiencing from the list below. 

• Lift Arm 

• Recorder 

• Print Quality 

• Gripper 

• Printer does not print. 

• Serial Number 

• Software 

• Hardware 

• Printer Driver 

• Labels 

• Ink Cartridges 

• Media 
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Lift Arm 
Select a problem to view the solution. 

• The lift arm is unable to pick from the printer or recorder. 

• The lift arm is unable to place the disc in the output bin. 
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The lift arm is unable to pick from the printer or recorder. 

 Important! Try these solutions in the order they are presented. 

• Update the firmware. To find the latest firmware, refer to the Downloads tab on the Support 
website. Navigate: www.rimage.com > Support > Desktop > 360i. Select the Downloads tab. 
Download the latest firmware. 

• Center the disc in the tray. This is a one-time solution. If this solution does not work, your 
Rimage 360i requires the attention of an authorized Rimage Repair Technician. Contact your 
Rimage reseller for repair and service options. 

• Rimage offers media kits that provide superior performance and exceptional convenience at 
a competitive price. For more information, see Rimage Media Kits. 

 

The lift arm is unable to place the disc in the output bin. 
• Your 360i requires the attention of an authorized Rimage Repair Technician. Contact your 

Rimage reseller for repair and service options. 
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Recorder 
There are recording failures. 

 Important! Try these solutions in the order they are presented. 

• Restart the computer.  

• Update the firmware. To find the latest firmware, refer to the Downloads tab on the Support 
website. Navigate: www.rimage.com > Support > Desktop > 360i. Select the Downloads tab. 
Download the latest firmware. 

• Reseat the USB connection at the Rimage 360i and the computer.  

 
1. Power off the Rimage 360i.  

2. Disconnect the USB cable. 

3. Connect the USB cable, ensuring that it is secure. 

4. Power on the Rimage 360i. 

• Reseat the power cable on the Rimage 360i and at the power source. 

 
1. Power off the Rimage 360i.  

2. Disconnect the power cable. 

3. Connect the power cable, ensuring that it is secure. 

4. Power on the Rimage 360i. 

• Use a different USB port. Sometimes Windows loses its connection to the port.  
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There may be an issue with your media. Rimage offers media kits that provide superior 
performance and exceptional convenience at a competitive price. For more information, see 
Rimage Media Kits. 
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Print Quality 
Select a problem to view the solution. 

• The finished disc has noticeable bands in the printed disc. 

• The print is streaky. 

• Ink does not dry. 

• Prints are smearing.  

• There is banding on the print. 

• Nothing prints on the disc. 

• All the jobs are rejected. 

• The print is grainy. 

• The print is not masking or prints on the hub.  

• The print is “off” color or is printing “faint.” 
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There are noticeable bands on the printed disc. 
Banding can be improved by increasing the ink saturation in the Rimage 480i printer driver. 
Select the appropriate instructions to change the ink saturation: 

Printing labels from CD Designer 

 Note: If you are using CD Designer, printing preferences are saved with the label file and are 
used instead of the printer driver settings. 

1. Open the label file with CD Designer.  

2. Select Print. The Printer window opens.  

3. Select the Document Properties button.  

4. Select the Colors tab.  

5. Move the Saturation slider toward “vibrant.”  

6. Select OK.  

7. Close the Printer window.  

8. Save the label file.  

9. Print the label again. 

 

Printing PDF files 

When printing with Acrobat (.PDF) files, change the Printing Defaults in the printer driver. 

1. From the Windows Start menu: 

 Navigate: Settings > Printers in Windows 2000. 

 Navigate: Settings > Printers and Faxes in Windows XP.  

2. Right-click on the Disc Color Printer 480i.  

3. From the drop-down menu, select Properties. The Disc Color Printer 480i Printing Properties 
window opens.  

4. Navigate: Advanced tab > Printing Defaults > Color tab  

5. On the Color tab, move the Saturation slider toward “vibrant.” 

6. Select OK.  

7. Print the label again. 

 

The print has streaks. 
Be sure you are using Rimage media.  Rimage offers media kits that provide superior 
performance and exceptional convenience at a competitive price. For more information, see 
Rimage Media Kits. 

• Clean or replace the ink cartridge. Refer to the Maintain the Rimage 360i section of the 
Rimage 360i User Guide.  
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Ink does not dry. 
Be sure you are using ink jet media.  Rimage offers media kits that provide superior performance 
and exceptional convenience at a competitive price. For more information, see Rimage Media 
Kits. 

Rimage • Lower the print quality settings. Refer to the Operate the Rimage 360i section of the 
360i User Guide. 

 

Prints are smearing. 
Be sure you are using ink jet media. Rimage offers media kits that provide superior performance 
and exceptional convenience at a competitive price. For more information, see Rimage Media 
Kits. 

• Clean or replace the ink cartridge. Refer to the Maintain the Rimage 360i section of the 
Rimage 360i User Guide. 

 

There is banding on the print. 

 Important! Try these solutions in the order they are presented. 

• Replace ink cartridge. Refer to the Maintain the Rimage 360i section of the Rimage 360i User 
Guide. 

 

Nothing prints on the disc. 

Important! Try these solutions in the order they are presented.  
• Reset the mask settings. Refer to the Operate the Rimage 360i section of the Rimage 360i 

User Guide. 

1. Navigate to the Printer folder in

2. Right-click on the . 

 Windows. 

Rimage 360i

3. Select Printing Preferences. 

4. Select the gs tab. Mask Settin

efault. 5. Select Set D

6. Select OK. 

 Recreate the label file. Refer to the Create a Label topic in the QuickDisc Online Help. •
 

All the jobs are rejected. 

ey are presented. 

• 

dow, select Preferences. 

 Important! Try these solutions in the order th

Deselect enable recording modifications. 

1. In the QuickDisc win

2. Select Recording. 

3. Clear the Enable Recording Modifications checkbox. 
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 Install a hard drive that meets the following optimum computer specifications.  

g Rimage media. Rimage offers media kits that provide superior 

•

 

The print is grainy. 

 Important! Try these solutions in the order they are presented. 

Be sure you are usin
performance and exceptional convenience at a competitive price. For more information, see 
Rimage Media Kits. 

 Replace the ink cartridges. Refer to the Maintain the Rimage 360i section of the Rimage 360i •
Printer User Guide. 

 sented. 

• 

Prin

ferences are saved with the label file and are 
gs. 

 opens.  

4.  Mask Settings tab.  

 discs have a stacking ring (raised area on the disc for stacking), you will 
e hub area setting appropriately. 

ow.  

. Save the label file.  

ain. 

Wh p ts in the printer driver. 

1. 

ows 2000. 

2. ter 480i.  

Preferences. The Disc Color Printer 480i Printing 
Preferences window opens.  

 

The print is not masking or prints on the hub. 

Important! Try these solutions in the order they are pre

Follow these steps to adjust the mask settings: 

ting labels from CD Designer 

 Note: If using CD Designer, printing pre
 used instead of the printer driver settin

1. Open the label file with CD Designer.  

2. Select Print. The Printer window

3. Select the Document Properties button.  

Select the

5. Make your changes to the inner and outer hub diameter under the Standard Area 
settings.  

 Note: If your
need to make changes to th

6. Select OK.  

7. Close the Printer wind

8

9. Print the label ag

 

Printing PDF files 

en rinting with .PDF files, change the Printing Defaul

From the Windows Start menu: 

 Navigate: Settings > Printers in Wind

 Navigate: Settings > Printers and Faxes in Windows XP.  

Right-click on Disc Color Prin

3. From the dropdown menu, select 
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4. Select the Mask Settings tab.  

Make your5.  changes to the inner and outer hub diameter under the Standard Area 

(raised area on the disc for stacking), you will 
ake changes to the hub area setting appropriately. 

ow.  

9. 

 Note: If that doesn’t work, reinstall the printer driver. Link to that process 

eplace the ink cartridges. Refer to the Maintain the Rimage 360i section of the Rimage 360i 

settings.  

 Note: If your discs have a stacking ring 
need to m

6. Select OK.  

7. Close the Printer wind

8. Save the label file.  

Print the label again. 

 

The print is “off” color or is printing “faint.” 
R
Printer User Guide. 
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Gripper 
The gripper fingers are not clamping properly. 
You could have warped or defective media.  

Be sure you are using Rimage media. Rimage offers media kits that provide superior 
performance and exceptional convenience at a competitive price. For more information, see 
Rimage Media Kits. 
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Printer does not print 
The printer sounds like it is printing, but it does not print the disc. 
1. Download and install the latest Service Pack. To find the latest service pack, refer to the 

Downloads tab on the Support website. Navigate: www.rimage.com > Support > Desktop > 
360i. Select the Downloads tab. Download the latest service pack. 

2. Open the Disc Color printer driver. 

 Using Windows 2000, navigate: Start > Printers. The Printers window opens.  

 Using Windows XP, navigate: Start > Printers and Faxes. The Printers and Faxes 
window opens. 

3. Right-click on Disc Color 480i. A dropdown menu displays.  

4. From the dropdown menu, select Printing Preferences. The Disc Color 480i Printing 
Preferences dialog box opens.  

5. Select the Mask Settings tab.  

6. Select Set Default. All mask settings are changed to the default settings. 

 Note: If you are printing on the discs from the Rimage media kits, set the Inner Diameter 
setting to 24 mm. 

7. To save the change, select OK.  

8. Close the Printers window.  

9. Restart the computer. 

10. Resubmit your job. 
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Serial Number 
Select a problem to view the solution. 

• Where can I find my serial number?  

• Can I print serial numbers on labels? 

• Why does not my serial number increment? 
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Where can I find the serial number? 
The Locate Your Rimage Product Serial Number document shows the possible locations for a 
serial number label and what the label looks like. 

 

Can I print serial numbers on labels? 
Yes, you can print serial numbers on labels. To add a serial number to your label, refer to the CD 
Designer Online Help. Configure QuickDisc so the serial number increments. 

1. In QuickDisc, select Preferences. The Preferences window opens.  

2. Select Printing. The Printing Preferences display.  

3. From the Save label counter when printing dropdown list, select Save.  

4. To save the change, select OK.  

 

Why does not my serial number increment? 
Configure QuickDisc so the serial number increments. 

1. In QuickDisc, select Preferences. The Preferences window opens. 

2. Select Printing. The Printing Preferences display.  

3. From the Save label counter when printing dropdown list, select Save.  

4. To save the change, select OK.  
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Software 
Select a problem to view the solution. 

• QuickDisc does not recognize the Rimage 360i. 

• What other software can I use to create my labels? 

• Can the Rimage software record video files on a DVD to be played in a DVD player for 
television? 

• Can Rimage software record a pre-built ISO disc image file? 

• What operating systems are compatible with my Rimage software? 

• What graphic formats are supported by CD Designer? 

• Why is my throughput slow when using QuickDisc? 

• QuickDisc crashes. 

• CD Designer crashes. 
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QuickDisc does not recognize the Rimage 360i. 
This may be a problem with the printer, autoloader, or recorder. (link to printer, autoloader, and 
recorder processes here. Select the appropriate section to view solutions. 

Printer 

 Important! Try these solutions in the order they are presented. 

• Ensure that the Rimage 360i is powered on.  

 
 

 

• Ensure that the USB cable is firmly connected to the computer and the autoloader.  

• Ensure that the ink cartridges are installed and latches are closed.  

 
 

 

• Ensure that the protective tape is removed from the ink cartridges. 

• Ensure that the installation was completed properly. 
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 In Windows 2000, a warning message that the software you are about to install does not 
contain a digital signature displays. To install the software, select Yes. 

 In Windows XP, a warning message that the software has not passed Windows Logo 
testing displays. To install the software, select Continue Anyway.  

Autoloader 

 Important! Try these solutions in the order they are presented. 

• Restart QuickDisc.  

• Use a different USB port because Windows sometimes loses connection to the port. See 
previous verbiage 

• Reseat the USB connection at the Rimage 360i and the computer. Then reseat the power 
cable at the Rimage 360i and at the power source. 

 
1. Power off the Rimage 360i.  

2. Disconnect the cables. 

3. Connect the cables, ensuring that they are all secure. 

4. Power on the Rimage 360i. 

• Reinstall CP2101 device.  

1. Navigate to the Device Manager. 

a. Right click on My Computer. 

b. Select Properties. The System Properties window opens. 

c. Select the Hardware tab.  

d. Click Device Manager. The Device Manager window opens. 

2. Select the Ports. 

3. Select and delete the CP2101 device. 

4. Restart the computer to reinstall the device. 

Recorder 
• Restart the computer.  

• Update the firmware. To find the latest firmware, refer to the Downloads tab on the Support 
website. Navigate: www.rimage.com > Support > Desktop > 360i. Select the Downloads tab. 
Download the latest firmware. 
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• Reseat all of the cables connecting to the Rimage 360i. 

 
1. Power off the Rimage 360i.  

2. Unplug all of the cables. 

3. Plug in all of the cables, ensuring that they are all secure. 

4. Power on the Rimage 360i. 

• Use a different USB port because Windows sometimes loses connection to the port. See 
previous 

What other software can I use to create my labels? 
You can use any graphics program that can save to a PDF file. 

 Note: Using PDF files does not allow serial numbers or merge fields. Rimage recommends 
using CD Designer to use these features.  

 

Can the Rimage software record video files on a DVD to be played in a DVD 
player for television? 
You must use a DVD authoring program to produce the video files and convert them to the 
correct format for DVD players. 

• If you have the global video image file created, follow these steps: 

1. From the QuickDisc 7.x toolbar select New. 

2. Select the More Tasks tab. 

3. Select Record an Image File to Disc. 

4. Follow the wizard prompts to complete the order. 

• If you have the pre-authored video files and folder created, follow these steps: 

1. From the QuickDisc 7.x toolbar, select New. 

2. Select the DVD tab. 

3. Select Video DVD. 

4. Follow the wizard prompts to complete the order. 
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Can Rimage software record a pre-built ISO disc image file? 
All versions of Rimage software can record standard ISO image files. To record a standard ISO 
image file, use the Image File to Disc function in QuickDisc. Rimage software cannot record 
non-standard disc image files. 

 

What operating systems are compatible with my Rimage software? 
Rimage 360i Software versions 7.0 and later are supported only on the following Windows 
operating systems: 

• Windows 2000 Professional with SP4 

• Windows XP Professional with SP1 or SP2 

• Windows 2003 Server 

 

Why is my throughput slow when using QuickDisc? 
Some USB 2.0 cards do not support the high speed mode. 

• Use a high quality USB 2.0 adaptor card that supports the high speed mode. 

• Shut down all other applications when using QuickDisc. 

 

QuickDisc crashes. 
• QuickDisc may crash if you are using a graphic file as your label instead of a BTW or PDF. 

• Rimage supports the Rimage 360i only on the following operating systems: Windows 2000 
Professional SP4, Windows XP Professional SP1 or SP2, Windows Server 2003. Ensure that 
you are using one of the supported operating systems. To view information about your 
operating system: 

1. From the Start menu, right-click on My Computer. 

2. Select Properties. 

3. The system information is displayed on the General tab. 

• Reseat USB cables. 

 
1. Power off the Rimage 360i.  

2. Unplug all of the cables. 
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3. Plug in all of the cables, ensuring that they are all secure. 

4. Power on the Rimage 360i. 

• Disable any antivirus software that is running.  

 Caution! This workaround may make your computer or your network more vulnerable to 
attack by malicious users or by malicious software such as viruses. Rimage does not 
recommend this workaround but we are providing this information so that you can 
implement this workaround at your own discretion. Use this workaround at your own risk.   

Important:  
An antivirus program is designed to help protect your computer from viruses. You must 
not download or open files from sources that you do not trust, visit Web sites that you do 
not trust, or open e-mail attachments when your antivirus program is disabled.  If you are 
connected to the Internet or a network during the time your antivirus software is disabled, 
your computer is vulnerable to attacks. 

 

A firewall is software or hardware that creates a protective barrier between your computer 
and potentially damaging content on the Internet or network.  A firewall can help prevent 
hackers or malicious software (such as viruses and worms) from gaining access to your 
computer through a network or the Internet. 

• Connect your Rimage 360i to a different computer. 
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Graphics 
What graphic formats are supported by CD Designer? 
• Rimage recommends using BMP, TIF, WMF, and JPG files. All files, including JPG files, 

should be saved at 300 DPI.  

• TIF files must be in an RGB color model without LZW compression. If a CYMK TIF file is the 
only file available, convert the file to an RGB format with a graphics application. 

 Note: Transparency in graphic files will appear white in CD Designer and is not supported.  
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Hardware 
Select a problem to view the solution. 

• What do the status lights on the front of the Rimage 360i indicate? 

• Can I have other USB devices plugged into the same USB card as the Rimage 360i? 

• Can I plug the Rimage 360i into a USB hub? 

• Can I send jobs from a remote computer to the Rimage 360i? 

• Can I place files on my cache hard drive? 

• Can the Rimage 360i print on the hub of the disc? 

• The Rimage 360i has less output than expected. 
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What do the status lights on the front of the Rimage 360i indicate? 
Refer to the Identify the Parts section of the Rimage 360i User Guide. 

 

Can I have other USB devices plugged into the same USB card as the 
Rimage 360i? 
Rimage recommends that you reserve the USB 2.0 card for the Rimage 360i. 

 

Can I plug the Rimage 360i into a USB hub? 
You must connect the Rimage 360i USB cable directly into a USB 2.0 port on the computer that is 
attached to the Rimage 360i. 

 

Can I send jobs from a remote computer to the Rimage 360i? 
You must create jobs from the Rimage 360i Software on the computer that is attached to the 
Rimage 360i. 

 

Can I place files on my cache hard drive? 
No, cache drives should be reserved for recording purposes only. Placing files on the cache drive 
adversely affects performance. Rimage recommends that you use your cache hard drive only for 
recording purposes. 

 

Can the Rimage 360i print on the hub of the disc? 
Yes. Refer to Changing the printable area settings section in the Rimage 360i User Guide.  

 

The Rimage 360i has less output than expected. 
• Ensure that your computer meets the requirements listed in the Rimage 360i User Guide. 

Refer to the Learn More section of the user guide. 

 Note: If you are producing DVDs, your computer must meet the optimum computer 
requirements for maximum output. 

• Ensure that your computer has a USB 2.0 port. 

 Refer to your computer documentation.  

 If your computer has a USB 2.0 port, ensure the USB card has the high speed mode. 
Rimage recommends purchasing the Rimage USB 2.0 Kit. 

• Use the Rimage USB 2.0 kit for better performance. Contact your Rimage reseller. 

 USB 2.0 cards come in three transfer modes: Low, full and high. The Rimage 360i card 
provides the high speed mode.  
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 The Rimage USB2 kit has been thoroughly tested with the Rimage 360i. The Rimage 
USB2 card performed best in these tests and provided the maximum output. 

July 31, 2007 ©Rimage 2007 24 



Rimage 360i™ Knowledge Base 
 

 

Printer Driver 
After changing a printer driver setting, the next print did not reflect the 
change. 
If you are using CD Designer labels, the printer driver settings are saved with the label files. You 
will need to change the settings in the label files in order to have the print reflect the change. 

Change Printer Driver Settings 
If you are using CD Designer, you must change the printer driver settings through CD Designer 
with the label file open. The CD Designer label file settings override the printer driver settings.  

1. From CD Designer, open the label file.  

2. Navigate: File > Print. The Print window opens. 

3. Select Printer Properties.  

4. Make any desired changes to the printer settings.  

5. Select OK.  

6. Close the Print window.  

7. Save the label file.  

8. Print the disc. 

Change Label Templates 
You can change the label template so all labels created afterward will have the desired change. 

1. Open the Rimage.btw file, located in “C:\Program Files\Rimage\CD Designer\” 

2. Navigate: File > Print. The Print window opens. 

3. Select Document Properties.  

4. Make any desired changes to the printer settings.  

5. Select OK.  

6. Close the Print window.  

7. Save the label file as Rimage.btw. 

 

July 31, 2007 ©Rimage 2007 25 



Rimage 360i™ Knowledge Base 
 

 

Labels 
Select a problem to view the solution. 

• What label formats does my Rimage 360i print? 

• How can I merge data on my label? 

• Why does not my label print when I selected a label? 
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What label formats does my Rimage 360i print? 
• Rimage recommends using BMP, TIF, WMF, and JPG files. All files, including JPG files, 

should be saved at 300 DPI.  

• TIF files must be in an RGB color model without LZW compression. If a CYMK TIF file is the 
only file available, convert the file to an RGB format with a graphics application. 

 Note: Transparency in graphic files will appear white in CD Designer and is not supported. 

 

How can I merge data on my label? 
• If you are using CD Designer 7.51 or later, open the Using merge fields document for 

instructions. 

• If you are using CD Designer 7.5 or earlier, open the Using advanced merge fields for 
instructions. 

 

Why does not my label print when I select a label? 
Simulate printing may be enabled.  

To clear this option: 

1. In QuickDisc, select Preferences. 

2. Select Printing. 

3. Clear the Simulate printing checkbox. 

4. To save the change, select OK. 
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Ink Cartridges 
Select a problem to view the solution. 

• Can I use ink cartridges other than Rimage authentic cartridges in the Rimage 360i? 

• Can I refill my ink cartridges? 

• How do I use only the black cartridge for printing a label? 
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Can I use ink cartridges other than Rimage authentic cartridges in the 
Rimage 360i? 
The printer will operate only with authentic Rimage ink cartridges. These are available from your 
Rimage reseller. 

 

Can I refill my ink cartridges? 
If you refill your Rimage ink cartridges, you may void your warranty and maintenance contract. 
You must use only authentic Rimage ink cartridges. For more information, see Rimage Media 
Kits. 

 

How do I use only the black cartridge for printing a label? 
You have two options: 

• Install only the black ink cartridge. 

OR 

• Set printing to grayscale. With the label file open in CD Designer: 

1. Navigate: File > Print. 

2. Select Document Properties.  

3. Select the Color tab. 

4. Select the Grayscale checkbox. 

5. Select the Black Print Cartridge Only option. 
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Media 
Select a problem to view the solution. 

• Can I use thermal printable CDs or DVDs on the Rimage 360i? 

• Can I use rewritable media? 

• Can I copy a DVD to a CD or a CD to a DVD? 
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Can I use thermal printable CDs or DVDs on the Rimage 360i? 
You must use inkjet printable discs. Rimage offers media kits that provide superior performance 
and exceptional convenience at a competitive price. For more information, see Rimage Media 
Kits. 

 

Can I use rewritable media? 
You can use rewritable media, but Rimage systems do not allow you to write to the media more 
than once. In other words, you lose the rewritable functionality of the media. Rimage offers media 
kits that provide superior performance and exceptional convenience at a competitive price. For 
more information, see Rimage Media Kits. 

 

Can I copy a DVD to a CD or a CD to a DVD? 
You can copy the data from one media type to another media type by moving all the data files to 
the local hard disk and selecting a Data CD or Data DVD function.  
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If all else fails 
• Your Rimage 360i requires the attention of an authorized Rimage Repair Technician. Contact 

your Rimage reseller for repair and service options. 

• Contact Rimage Technical Support . 
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